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1. Document Details 
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1.1 Summary 
This is the release for the Vector File Converter Full/Trial release and Vector File Thumbnail Creator V1.0.02 
user guide. 

1.2 Supersedes 
None. 

1.3 Version History 
Version Date Details 
1.00 1st December 2016 Authors & Contributors at this version 

Ian Wadsworth. 
 
First issue.  

   

1.4 Copyright 
This document, test files, executables and related files are copyright of Ian Wadsworth (except where 
indicated), and must not be distributed to any un-authorised testers without the consent of Ian Wadsworth. 
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2. Release and System 
Requirements Information 
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2.1 Disclaimer 
The propriety file formats used FCM (Brother), GSD/GST (Graphtec), Slice (Making Memories) and Studio 
(Silhouette America). There is no association between the Intellectual Property owner of this application and 
Silhouette America. This is NOT Brother, Graphtec, (Making Memories) or Silhouette America approved. In 
other words, they don’t own or control it. 

2.2 Copyright of Converted Files 
This creates a copy of the FCM, GSD/GST (GSD template files), Slice, or Studio files/images. This does not 
change the copyright or licence terms of any of the converted files. These still belong to the author/owner of the 
original files/images, which will also apply to the converted/extracted files/images. 

2.3 Software Use 
• The software is supplied as is. It may contain defects, and may not be fit for purpose. 
• The author cannot be held responsible for any loss of data caused by using the application. 
• It has been checked for viruses, but it is up to the user to check that their system have the latest anti-

virus software installed and enabled. 

2.4 Copyright Acknowledgements 
All registered trademarks are recognised, and are not used to exclusively promote the application. 

2.5 End User Licence 
Please read the document ‘eula.rtf’. 
 

• The software is licensed, and is not owned. 
• No selling or renting of the executable file 
• Internationally copyright protected. 
• It may not be re-sold, rented, etc. 
• Please don't distribute the executable file, link it to this website 

2.6 3rd Party Licences 
The software uses a number of Open Source modules from: - 
 

• DreamCatcher2k10, http://www.codeproject.com/Articles/59514/Simple-Tri-State-TreeView 

2.7 Release Notes 
The latest release/update is also available from the Ideas R Us Software website (http://www.ideas-r-us-
software.uk/), from the 
Downloads web page. 
 
A help forum is at http://www.ideas-r-us.co.uk/forum/ 

2.7.1 Limitations of the Free Release (Vector File Thumbnail 
Creator) 
SVG files are not created, only bitmap thumbnails. 

http://www.codeproject.com/Articles/59514/Simple-Tri-State-TreeView
http://www.ideas-r-us-software.uk/
http://www.ideas-r-us-software.uk/
http://www.ideas-r-us.co.uk/forum/
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2.7.2 Changes Made in Version 1.0.02 
2.7.2.1 New Features 
Added support for reading FCM files created for the SDX Roll Feeder. 

2.7.3 Changes Made in Version 1.0.01 
2.7.3.1 Issues Fixed 

• Brother FCM files that are corrupt or damaged caused an application error when thumbnail was viewed. 
Fixed. 

• Brother FCM files that have been created in Brother’s Desktop CanvasWorkspace, may create 
thumbnails with parts missing. Fixed. 

2.8 Reporting Issues (Bugs) 
Issues can be reported by going to the forum at http://www.ideas-r-us.co.uk/forum/. 

2.9 System Requirements 
• Requires Windows XP, Windows Vista, Windows 7, Windows 8.x or Windows 10. 
• A mouse or pointing device 
• A display with a minimum resolution of 800 x 600 pixels, colour or monochrome 
• At least 5MB of hard disk space 
• The application uses about 40MB of DRAM. 
• Requires the Microsoft .NET Framework 3.5 Service Pack 1 (Requires at least Service Pack 2 Win XP), 

if not already installed. The installer will detect if the framework is installed or not. 
o If you have Internet access it can be downloaded from http://www.microsoft.com/en-

gb/download/details.aspx?id=25150 (about 235MB) 
o If no Internet access, it may be on the operating systems install disk. 

 
The supplied files are: - 
  

VectorFileConverter.exe or VectorFileThumbnailCreator.exe 
VectorFileConverterUserGuide.pdf 
eula.rtf 
unins000.dat 
unins000.exe 

 

http://www.ideas-r-us.co.uk/forum/
http://www.microsoft.com/en-gb/download/details.aspx?id=25150
http://www.microsoft.com/en-gb/download/details.aspx?id=25150
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3. The Application 
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3.1 Main Features/Description 
It will batch convert the selected files to bitmap thumbnails in the specified folder. 
 
The four file types that are supported are FCM (Brother, Scan and Cut), GSD/GST (Graphtec, Craft ROBO), 
Studio/Studio3 (Silhouette America, Silhouette Studio), and Making Memories Slice, BN, DN, MN, and SN. 
 
The file conversion rate is dependant on the PC processor speed and also on the file size and complexity of the 
vector drawing. 
 
FCM   29,376 to 113,276 files per hour 
GSD/GST  7,094 to 29,794 files per hour 
Studio/Studio3  5,040 to 27,597 files per hour 
 
Any supported vector file can be dragged and dropped onto the application, and the preview image displayed. 
The displayed image can also be saved. 
 
Note: - The whole of the drawing will be converted, and not just what is on the virtual mat. 

3.1.1 Supported 
3.1.1.1 Brother FCM 

• Line Types, Cut, Draw, Cut and Draw 

3.1.1.2 Graphtec GSD/GST 
• Fill, Solid, Gradient 
• Stroke Colour and Stroke Dash Styles 
• Bitmap Images 

3.1.1.3 Making Memories Slice 
• Use the highest number of the file, e.g. DN8 instead on DN1, the quality will be better. 

3.1.1.4 Silhouette Studio/Studio3 
• Fill, Solid, Gradient 
• File Created in Silhouette Studio Versions 1.9, 2, 3 and 4 
• Text (Text Outlines, No Need to Convert to Paths Silhouette Studio Does it Automatically) 
• Stroke Colour and Stroke Dash Styles 
• Bitmap Images 
• Indications that Rhinestone or Sketch Styles may need to be ‘Released’ in the Designer Edition  

3.1.2 Not Supported 
3.1.2.1 Silhouette Studio/Studio3 

• Layers in Silhouette 3 
• Full implementation of Radial Gradient Fills 
• Rhinestones to Paths (use release in Silhouette Studio Designer Edition) 
• Sketch to Paths (use release in Silhouette Studio Designer Edition) 
• Perforated Cut Styles are not converted (they are not Detected) 
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• Unknown Image Type in Silhouette Studio Version 3 
• In Studio 3 format, the ‘Include Cut Data’ is not extracted 

3.2 Running the Application 
There are three ways that the Vector File Converter or Vector File Thumbnail Creator application can be 
started: - 
 

1. Clicking on the desktop program icon (if created). 
2. From the Start Menu -> Programs -> Ideas R Us Software -> Vector File Converter -> Vector File 

Converter (if created), or Start Menu -> Programs -> Ideas R Us Software -> Vector File Thumbnail 
Creator -> Vector File Thumbnail Creator (if created). 

3. By clicking on the VectorFileConverter.exe or VectorFileThumbnailCreator.exe  in the 
VectorFileConverter or VectorFileThumbnailCreator folder (where the application was 
installed). 

 
The main form will appear (see Picture 4 Screen Shot of the Vector File Thumbnail Creator). 
 
When the application is first run, there can be quite a long start up delay. After that, the start up will be much 
quicker. This will always be the case when the system is restarted. 

3.2.1 Errors when Reading in the Already Converted Files List 
 

• One or more already converted files entries cannot be read. 
• Cannot read in the list of files that have already been converted. 

 
The ‘already converted files’ will not be shown in the Tree View list of files. You will still be able to convert 
files, but could be converting files that have already been converted. 

3.2.2 Folder Locations for the Application Settings 
Their location depends on the Operating System. 
 
The Application Settings and User Data Files can be viewed from the Settings -> Settings Folder (see 6.3.1 
Settings Folder). The Licence File can be viewed from the Help -> Installation Folder (see 6.4.2 Installation 
Folder) menu. 
 
Picture 1 Reports Menu 

 

 
Picture 2 Help Menu 
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If the ‘Start Menu’ (see Picture 3 Start Menu Entry for the Vector File Thumbnail Creator) was selected during 
install (not for Windows 8.x), then the folders can be accessed by clicking on the folder link. 
 
Picture 3 Start Menu Entry for the Vector File Thumbnail Creator 

 

3.2.2.1 Application Settings and User Data Files 
The created data files are: - 
 

<ANY FILES> 

 
They are placed in a special folder called the Local Application Data. Microsoft describe this as “The directory 
that serves as a common repository for application-specific data that is used by the current, non-roaming user”. 
 
For Windows XP and lower, the default location is: - 
 

C:\Documents and Settings\<User Name>\Local Settings\Application 
Data\IdeasRUsSoftware\VectorFileConverter 
C:\Documents and Settings\<User Name>\Local Settings\Application 
Data\IdeasRUsSoftware\VectorFileConverter 

 
For Vista, Windows 7, Windows 8.x, and Windows 10, the default location is: - 
 

C:\Users\<User Name>\AppData\Local\IdeasRUsSoftware\VectorFileConverter 
C:\Users\<User Name>\AppData\Local\IdeasRUsSoftware\VectorFileConverter 

 
Where <User Name> is the name of the user account. 
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4. Main Form Overview 
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This is the main form after starting. 
 
Picture 4 Screen Shot of the Vector File Thumbnail Creator 

 
 

4.1 Drag and Drop a File 
Drag and Drop any supported vector file from a file viewer such as Explorer onto the Preview Image Box. 

Select the vector file, then click and hold the mouse button. When the mouse is moved it will change to a  
symbol (no drop). 

Drag the file onto the Vector File Thumbnail Creator’s Preview Image Box; the cursor will change to a  
symbol (drop and copy). Release the mouse button and the image should appear. 
 
If the Preview Image Box is hidden, drag the file to the Vector File Thumbnail Creator’s task bar button. The 
form will now be visible. 
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5. Quick Start 



Vector File Converter and Vector File Thumbnail Creator User Guide V1.0.02 
 

Page 19 

Some of this is duplicated from other sections of the user guide. 
 

5.1 Selecting the Source Folder of the Files to Convert 
See section 7.1 Source Folder for more information. 
 
Click on the  button in the Source Folder panel, and select the drive and folder where the files to be 
converted are. 
 
Picture 5 Source Folder Group Panel 

 
 
There may be a delay until anything appears in the tree view of files (see Picture 15 Files Available for the 
selected File Type). 
 
Picture 6 Selecting the Source Folder 

 
 
Picture 7 The Selected Source Folder 

 

5.2 Selecting the Destination Folder of the 
Converted/Thumbnail Files 
See section 7.2 Destination Folder for more information. 
 
If the ‘Use Source Folder for Destination’ check box is ticked, then the Destination Folder will be the same as 
the Source Folder. 
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Picture 8 Destination Folder Group Panel 

 
 
If the ‘Use Source Folder for Destination’ check box is not ticked, then click on the  button in the 
Destination Folder panel, and select the drive and folder (or create a new folder) where the converted files are 
to be saved. 
 
Picture 9 Selecting the Destination Folder 

 
 
Picture 10 The Selected Destination Folder 

 

5.3 Selecting the Files to Convert 
See section 7.3 File Types for more information. 
 
Select the file type to be converted, and the Thumbnail/Preview Size (100 to 400, and Actual). Using ‘Actual’ 
with a drawing size of 10mm x 10mm will create a thumbnail 10 pixels x 10 pixels. 
 
Note: - The whole of the drawing will be converted, and not just what is on the virtual mat. 
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Picture 11 File Types Group 

 
 
Picture 12 File Exists Group 

 
 
Picture 13 Thumbnails Group 

 
 
Picture 14 Thumbnail Sizes 

 
 
Select the files or folders to be converted by checking or un-checking the check boxes. The number of selected 
files for the file type will be shown (Picture 15 Files Available for the selected File Type). See section 8 Files to 
Convert Tree View for more information. 
 
Only the sub-folder name appears in the Tree View, and not the drive name and any folders above. 
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Picture 15 Files Available for the selected File Type 

 

5.4 Converting the Files 
See section 8.1 Converting for more information. 
 
Click on the ‘Convert’ button to begin the conversion. 
 
During the conversion, the number of files converted will be displayed in the status bar. See section 7.9 Status 
Bar for more information. 
 
Picture 16 Status Bar During Conversion 

 
 
After the conversion is complete a message box displays the files converted status. Files converted with errors 
will not have a thumbnail created. 
 
Picture 17 Conversion Complete 

 
 
The converted files with no errors will be removed from the ‘Files to Convert’ tree view. Any files converted 
with errors, will still be selected. 
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Picture 18 Files Converted with Errors 

 

5.5 Selected File Details and Preview Image 
5.5.1 Selected File Details 

• File Name 
• File Size 
• Time Stamp 
• Drawing Size, in millimetres and inches 

5.5.2 Show Preview 
When the ‘Show Preview’ check box is ticked, a preview image of the ‘whole’ drawing will be displayed. 
 
For the Brother FCM file format, Black lines are either cutting or drawing, Red lines are for cutting, and the 
Blue lines are for drawing. 
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Picture 19 Selected File Details Group 
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Picture 20 A Thumbnail cannot be created from the Selected File 

 

5.5.3 Drag and Drop a File onto the Preview Image Box 
Any supported vector file can be dragged and dropped from any location onto the Preview Image Box (see 
section 4.1 Drag and Drop a File). 
 
When a vector file without any errors is dragged and dropped onto the Picture Image Box, the ‘Convert and 
Save Preview’ button will be enabled (see Picture 21 The Convert and Save Preview button is enabled), and the 
preview image can be saved as a PNG file. The pixel size selected will be used (see section 7.5 Thumbnails). 
 
The location of the saved PNG is where the vector file was dragged from, e.g., a file dragged from the Desktop 
will be saved back to the Desktop. The ‘Destination Folder’ location will be ignored. 
 
Picture 21 The Convert and Save Preview button is enabled 

 

5.6 Viewing the Files Converted Report Log and the 
Files Converted with Errors, Info, or Warnings Log 
 
See section 6.2.1 Files Converted Log and 6.2.2 Error, Info, and Warning Log for more information. 
 
Click on Reports on the menu, and select the Files Converted Log menu item. This is a list of the files 
converted with or without errors, and other conversion statistics. 
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Picture 22 The Files Converted Log 

 
 
Click on Reports on the menu, and select the Error/Info/Warning Log menu item. This is a list of the files 
converted with errors, info, or warnings. 
 



Vector File Converter and Vector File Thumbnail Creator User Guide V1.0.02 
 

Page 27 

Picture 23 The Files Converted with Errors. Info or Warnings Log 

 



Vector File Converter and Vector File Thumbnail Creator User Guide V1.0.02 
 

Page 28 

6. Menu 
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• File Menu 
• Reports 
• Settings 
• Help Menu 

 

6.1 File Menu 
 

 
 

• Exit 

6.1.1 Exit 
Menu -> File -> Exit 
Alt + F4 
 
Exit or closes the application. 

6.2 Reports Menu 

 
 

• Files Converted Log 
• Error/Info/Warning Log 
• Reports Folder 

 
During the conversion, two logs will be created. Any existing entries in these log files will be appended to the 
end of the log files. 
 
The log files are stored in a special folder called the Local Application Data. Microsoft describe this as “The 
directory that serves as a common repository for application-specific data that is used by the current, non-
roaming user”. 
 
For Windows XP and lower, the default location is: - 
 

C:\Documents and Settings\<User Name>\Local Settings\Application 
Data\IdeasRUsSoftware\VectorFileConverter 

 
For Vista, Windows 7, Windows 8.x and Windows 10, the default location is: - 

C:\Users\<User Name>\AppData\Local\IdeasRUsSoftware\VectorFileConverter 

 
Where <User Name> is the name of the user account. 
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6.2.1 Files Converted Log 
Menu -> Reports -> Files Converted Log 
 
The report contains: - 
 

• Start and end time 
• Total files converted 
• Time taken to convert 
• Total size of the files uploaded for conversions 
• Total size of the converted files downloaded 
• A list of the files converted with no errors, with errors and not converted 
• A list of Thumbnails not created 

 
Picture 24 The Files Converted Log 

 
 

6.2.2 Error, Info, and Warning Log 
Menu -> Reports -> Error/Info/Warnings Log 
 
This is just a list of all the errors and warnings found during conversions. The files converted are in the Files 
Converted Log file. 
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The report contains: - 
 

• The start and end time of the conversion 
• Any errors and warnings during conversion, with the effected file 

 
Picture 25 The Files Converted Error/Info/Warning Log 

 

6.2.3 Reports Folder 
Menu -> Reports -> Reports Folder 
 
This will open the folder where the report log files (*.txt) are stored. If it cannot, an error message will be 
displayed. 
 
Picture 26 Reports Folder 

 

6.3 Settings Menu 
 

 
 
• Clear the Already Converted Files List 
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6.3.1 Settings Folder 
Menu -> Settings -> Clear the Already Converted Files List 
 
This will clear the list of Already Converted Files, so they will no longer appear as green in the ‘Files to 
Convert’ tree view when the ‘Show the Already Converted Files’ check box is ticked. 
 
Picture 27 Confirm Clearing the Already Converted Files List 

 
 
Picture 28 The List has been cleared 

 
 
Picture 29 Trying to clear an Empty List 
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Picture 30 The Files Already Converted are Shown in Green 

 
 
Picture 31 After the Files Already Converted List has been cleared 

 

6.4 Help Menu 
 

 
 

• User Guide 
• Installation Folder 
• Check for Updates 
• About 
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6.4.1 User Guide 
Menu -> Help -> User Guide 
 
You are reading it! This will open the PDF User Guide. A PDF reader must be installed to view the User Guide; 
otherwise an error message will be displayed. 
 
It is located in the Installation Folder, or in the Documents sub-folder (see 6.4.2 Installation Folder). 

6.4.2 Installation Folder 
Menu -> Help -> Installation Folder 
 
This will open the folder where the Vector File Converter is installed. If it cannot, an error message will be 
displayed. 
 
Picture 32 Installation Folder 

 
 

6.4.3 Check for Updates 
Menu -> Help -> Check for Updates 
Ctrl + U 
 
Checks if there is an update to the current application. 
 
The latest release/update is also available from the Ideas R Us Software website (http://www.ideas-r-us-
software.uk), from the Downloads web page. 
 
If the version is up to date, the message box in Picture 33 The Current Version is up to Date will be displayed. 
 
If there is an update available, the message box in Picture 34 There is a New Version Available will be 
displayed. 
 
If there is a problem with the network connection or the update server, the message box in Picture 35 Network 
Connection Problem or Picture 36 Update Server Problem will be displayed. 
 
Note: There may be a delay before a pop-up message box, or an error message appears. 
 

http://www.ideas-r-us-software.uk/
http://www.ideas-r-us-software.uk/
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Picture 33 The Current Version is up to Date 

 
 
Picture 34 There is a New Version Available 

 
 
Picture 35 Network Connection Problem 

 
 
Picture 36 Update Server Problem 

 
 

6.4.3.1 Download the New Version 
To download the new version, click the ‘Yes’ button in Picture 34 There is a New Version Available, the ‘Save 
As’ dialogue box will appear (see Picture 37 Select the Location to Save the Set up File). Clicking the ‘No’ 
button will cancel the download. 
 
Select the folder where the download file is to be saved (the file name can be renamed if required), then click 
the ‘Save’ button. After the file has finished downloading, a message will be displayed. Click the ‘OK’ button. 
 
Note: There is a short delay while the file is downloading. 
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Picture 37 Select the Location to Save the Set up File 

 
 
Picture 38 The File has downloaded 

 

6.4.3.2 Installing the Update 
To install the update, the Vector File Converter application must be closed down. 
 
An installation guide is available if help if needed with the install. See the Downloads web page from the Ideas 
R Us Software website (http://www.ideas-r-us-software.uk). 

6.4.3.3 Other Error Messages 
These are system errors. 
 

• The version information on the server is incorrect. 
• The version infomation file on the server is missing. 
• The download link on the server is missing. 
• The setup file on the server is missing. 

 
Note: Under certain conditions if the server is down or there is no network connection, these can also be 
displayed. 

http://www.ideas-r-us-software.uk/
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6.4.4 About 
Menu -> Help -> About 
F1 
 
Shows the ‘Vector File Thumbnail Creator’, which is just version information, and where to report issues with 
the application. 
 
Picture 39 The ‘Abort’ Form for the Full Version 
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7. Group Panels and Status Bar 
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7.1 Source Folder 
 
Picture 40 Source Folder Group Panel 

 
 
Click on the  source folder button, and select the drive and folder where the files to be converted are. There 
may be a delay until anything appears in the tree view of files (see section 8 Files to Convert Tree View). 
 
Picture 41 Selecting the Source Folder 

 
 
Picture 42 The Selected Source Folder 

 

7.1.1 Error Messages 
 

• The drive is not ready. 
• The drive is full. 

7.2 Destination Folder 
 
Picture 43 Destination Folder Group Panel 
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If the ‘Use Source Folder for Destination’ check box is ticked, then the Destination Folder will be the same as 
the Source Folder. 
 
If the ‘Use Source Folder for Destination’ check box is not ticked, then click on the  destination folder 
button, and select the drive and folder (or create a new folder) where the converted files are to be saved. 
 
Picture 44 Selecting the Destination Folder 

 
 
Picture 45 The Selected Destination Folder 

 
 
The destination path and the free disk space will be shown for the selected drive, or an error message if there is 
not enough space to do the conversion. 

7.2.1 Single Destination Folder 
If un-checked, the folder structure will be maintained. It will be the same as the selected source folder. 
 
Check this to place all the converted files into a single folder. Not a good idea if there are many files to convert. 

7.2.2 Error Messages 
 

• The drive is not ready. 
• The drive is full. 

7.3 File Types 
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Picture 46 File Types Group Panel 

 
 
This will filter out only the selected file types, which are displayed in the tree view of files (see section 8 Files 
to Convert Tree View). 

7.4 File Exists 
 
Picture 47 File Exists Group Panel 

 
 
When there is a file on the destination folder with the same name as the new PNG file, then do one of the 
following: - 
 

• Rename it. The old PNG is kept, and the new PNG file has a number in brackets (starting at 1) appended 
to it, e.g. myfile (1).png 

• Overwrite the old PNG file with the new PNG file. 
• Discard the new PNG file; the old PNG file is kept. 

 

7.5 Thumbnails 
 
Picture 48 Thumbnails Group 

 
 
The Thumbnail/Preview Sizes are from 100 to 400, and Actual. Using ‘Actual’ with a drawing size of 10mm x 
10mm will create a thumbnail 10 pixels x 10 pixels. 
 
Note: - The whole of the drawing will be converted, and not just what is on the virtual mat. 
 
Picture 49 Thumbnail Sizes 
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7.6 Selected File Details 
 
Picture 50 Selected File Details Group 

 
 

7.6.1 Selected File Details 
• File Name 
• File Size 
• Time Stamp 
• Drawing Size, in millimetres and inches 

7.6.2 Show Preview 
When the ‘Show Preview’ check box is ticked, a preview image of the ‘whole’ drawing will be displayed. If the 
selected file cannot be converted to a bitmap, an error image is displayed. 
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Picture 51 A Thumbnail cannot be created from the Selected File 

 

7.7 Show Converted 
 

 
 

 
 
This will either show which files have already been converted if the check box has been ticked (shown in 
green), otherwise any previously converted files will not show in the tree view list. 
 
An already converted file is available for conversion if either the date and time stamp has changed, or the file 
size has changed. 
 
The list of already converted files in store in the file ConvertedFileEntryList.dat, in the reports folder (See 
6.2.3 Reports Folder). 
 
For more details, see 8 Files to Convert Tree View. 

7.8 Expand All Nodes 
 

 
 

 
 
This will either expand all the nodes in the tree view to show all the files, or it will collapse all the nodes. 
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7.9 Status Bar 
 

• The conversion progress so far 
• The number of files converted and the total files to be converted 
• The elapsed time for the conversions. 

 
Picture 52 Status Bar 
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8. Files to Convert Tree View 
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If there are any files of the selected file type in the selected folder, then there will be check boxes and icons (see 
Picture 53 Files Available for the Selected File Type), otherwise there will be no check boxes (see Picture 55 
No Files for the Selected File Type). 
 
If the ‘Show the Already Converted Files’ box is ticked, then any previously converted files are shown in green, 
otherwise they are not shown at all (see Picture 54 Files Available for the selected File Type Showing Already 
Converted Files). 
 
Each file can be selected individually by ticking the check box next to the filename, or all the files in a folder 
can be selected by ticking the folder name. 
 
The tree can be expanded by clicking the ‘ ’ icon, and collapsed by clicking the ‘ ’ icon. 
 
Picture 53 Files Available for the Selected File Type 
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Picture 54 Files Available for the selected File Type Showing Already Converted Files 

 
 
Picture 55 No Files for the Selected File Type 

 
 

8.1 Converting 
Before the ‘Convert’ button is enabled: - 
 

• The source folder must be selected 
• The destination folder must be selected and have free space 
• Files are selected 

 
After all the above have been satisfied, the main form will look like Picture 56 Main Form Ready for 
Converting. 
 
Click on the ‘Convert’ button to begin the conversions. When all the selected files have been converted, a 
message box will appear  (see Picture 58 Conversion Complete), click on OK to finish. 
 
After conversions, the files that have converted without any errors are removed from the tree view list (see 
Picture 60 The Converted Files are removed from the Tree View). 
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Picture 56 Main Form Ready for Converting 

 
 
During conversion, most of the form’s controls will be disabled, except the ‘Cancel Conversion’ button. The 
status bar will indicate the number of files converted, the total number to convert, and the elapsed time taken so 
far (see Picture 57 Main Form During Conversion). 
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Picture 57 Main Form During Conversion 

 
 
Picture 58 Conversion Complete 

 
 
If the ‘Show the Already Converted Files’ box was ticked, then the converted files are shown in green, 
otherwise they are removed from the tree view list. 
 



Vector File Converter and Vector File Thumbnail Creator User Guide V1.0.02 
 

Page 50 

Picture 59 The Converted Files are shown in Green 

 
 
The converted files with no errors will be removed from the ‘Files to Convert’ tree view. Any files converted 
with errors, will still be selected. 
 
Picture 60 The Converted Files are removed from the Tree View 

 

8.1.1 Cancelling the Conversion 
Click on the ‘Cancel Conversion’ button, and a pop up will ask yes or no. The conversion is still going on in the 
background and will only be stop when the ‘Yes’ button is clicked. 
 
The operation has been cancelled will appear in the both the report logs, see the section 6.2 Reports Menu. 
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Picture 61 Cancelling the Conversion 

 
 
Picture 62 Conversion Cancelled 

 
 

8.1.2 Error Messages 
 

• Error creating the destination folder 
• Error reading the file 
• Error saving the PNG file 
• The drive is not ready 
• The drive is full 
• Cannot update and save the list of files that have already been converted 
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10. Appendix 
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10.1 Un-Installing 
The Vector File Converter or Vector File Thumbnail Creator application can be un-installed from the Start 
Menu (see Picture 63 Un-installing from the Start Menu). 
 
If there isn’t a Vector File Converter or Vector File Thumbnail Creator Start Menu folder, the program can be 
un-installed from the Windows ‘Add/Remove Programs’ control panel. 
 
It can also be un-installed from double clicking on the unins000.exe in the Vector File Converter or Vector 
File Thumbnail Creator installed folder. This is usually in the ‘C:\Program 
Files\IdeasRUsSoftware\VectorFileConverter’ or ‘C:\Program 
Files\IdeasRUsSoftware\VectorFileThumbnailCreator’ folder. 
 
The user created data files ConvertedFileEntryList.dat, FilesConvertedErrorInfoWarningLog.txt and 
FilesConvertedLog.txt will not be deleted. 
 
Picture 63 Un-installing from the Start Menu 

 
 
A confirmation pop-up message box will be displayed, click ‘Yes’ to install, and ‘No’ to cancel uninstall. 
 
Picture 64 Confirm Uninstall 

 
 
The Vector File Converter application has been successfully removed. 
 
Picture 65 Successfully Uninstalled 

 
 

10.2 Keyboard Shortcuts 
About   F1 
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Check for Updates Ctrl + U 
Exit   Alt + F4 
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